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COPYRIGHT 

This manual and the software accompanying It are copyrighted with all rights reserved. Neither this 
manual nor the software may be copied , in whole or In part, wllhout written consent of Challenger 
Software, except In the normal use of the software to make a single backup copy. This proprietary 
and copyright notice must be affixed to any backup copy. The backup copy may not be sold or given 
to another person except as part of a package that also Includes the original copy. 

© 1984 Challenger Software. All Rights Reserved . 

LIMITED WARRANTY 

Challenger software warrants that the software media are free from defects in materials and faulty 
workmanship under normal use for a period of ninety days from purchase. 
In the event of any physical defects In software media during the ninety days after purchase, 
Challenger Software will replace the software media at no charge to the original purchaser with proof 
of purchase. 
If the failure of the software media, in the judgement of Challenger Software, resulted from accident , 
abuse, or misapplication of the media, Challenger Software will have no responsibility to replace the 
media under this warranty. 

ALL IMPLIED WARRANTIES ON THE MANUAL AND SOFTWARE MEDIA, INCLUDING IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE 
LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF THE ORIGINAL RETAIL PUR· 
CHASE. 
CHALLENGER SOFTWARE MAKES NO WARRANTY OR REPRESENTATION, EITHER EXPRESS OR 
IMPLIED, WITH RESPECT TO THIS SOFTWARE, ITS MERCHANTABILITY, QUALITY, PERFOR· 
MANCE, OR FITNESS FOR ANY PARTICULAR PURPOSE. THE MANUAL AND SOFTWARE MEDIA 
ARE SOLD "AS IS." THE PURCHASER ASSUMES ALL RISK AS TO ITS QUALITY AND PERFOR· 
MANCE. 

IN NO EVENT WILL CHALLENGER SOFTWARE BE LIABLE FOR DIRECT, INDIRECT, SPECIAL, IN· 
Cl DENTAL, OR CONSEQUENTIAL DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE, 
ITS MEDIA, OR ITS DOCUMENTATION. Your sole and exclusive remedy In the event of defect In 
either the manual or the media on which the software Is distributed Is replacement as provided 
above. 

THE ABOVE WARRANTY AND REMEDIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHERS, 
WHETHER ORAL, WRITIEN, EXPRESSED, OR IMPLIED. No employee, dealer or agent , ls authorized 
to make any modification, extension, or addition to this warranty. 

Certain states do not allow the exclusion or !Imitation of Incidental or consequential damages, so 
lhe above limitation may not apply to you. 

Portions of this program are © 1983 Apple Computer, Inc., and have been licensed to Challenger 
Software to distribute for use In combination with Legacy. APPLE COMPUTER, INC. MAKES NO 
WARRANTIES, EITHER EXPRESSED OR IMPLIED, REGARDING THE ENCLOSED COMPUTER 
SOFTWARE PACKAGE, ITS MERCHANTABILITY, OR ITS FITNESS FOR ANY PARTICULAR PUR· 
POSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITIED BY SOME STATES. THE 
ABOVE EXCLUSION MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC 
LEGAL RIGHTS, AND YOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

Apple and Macintosh are registered trademarks of Apple Computer, Inc. 
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About This Manual 
Welcome to Legacy! Legacy brings a world of fantasy and 

adventure to your Apple MacintoshrMcomputer. In Legacy, 
you pose as Dagon Bathraal, a young magician in search of 
mystical orb. 

This manual describes how to play Legacy and what you 
must do to successfully complete your quest. Chapter one 
"Playing Legacy," gets you started, while chapter two'. 
"Dagon's Mysterious Quest," provides some background in­
formation on Dagon Bathraal and describes your role in 
Legacy. 

This manual assumes that you have read Macintosh the 
Macintosh owners manual. Before you play Legacy,' you 
should understand basic Macintosh concepts, such as mov­
ing the mouse, scrolling, choosing commands, and entering 
text. 
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Chapter One: 
Playing Legacy 

You are about to enter an imaginative world where you are 
to begin a great adventure. By typing English sentences, 
such as "take the shovel," "dig a hole," or "walk to the 
west" into your Macintosh, you will be able to control what 
happens in Legacy. If you make the wrong decisions, the 
consequences may include the death of Dagon Bathraal. If 
you are cunning and resourceful, you will be able to com­
plete Dagon's quest. 

Loading Legacy 
Legacy comes on two disks, "Legacy Part One," and 

"Legacy Part Two." To begin playing Legacy, turn the Macin­
tosh on and insert the disk "Legacy Part One" into the 
Macintosh disk drive. If you have two disk drives, insert the 
disk "Legacy Part Two" into the external drive. The title pic­
ture, depicting a magical scene on a moonlit mountainside, 
will appear on the screen. After a short pause, your quest 
will begin and you will be placed on the edge of the Frimlock 
Forest. 

(If you should happen to accidentally insert the disk 
"Legacy Part Two" first, don't worry. A dialog box informing 
you of your mistake will appear, and clicking the OK button 
will eject the disk.) 
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The Screen 
As you begin your quest, you will see a screen composed 

of three main elements: the menu bar, the graphics window, 
and the text window. 

The menu bar contains six pull-down menus. These 
menus and their functions will be explained as you read this 
chapter. Also, all six menus are explained in the last section 
of this chapter, "Legacy's Menus." 

The graphics window (the center portion of the screen) is 
where illustrations of your surroundings shall appear. 
Resourceful magicians never forget to look for clues in the 
illustrations. 

The text window (the bottom portion of the screen) is 
where Legacy provides a description of your location, its 
scenery, and any ongoing action. Whenever a prompt (>)ap­
pears, you are to provide a command that describes what 
you want to do next. In the text window title bar, there is a 
short name for your location. 

On the right-hand side of the text window, you will notice 
a scroll bar. If you wish to review any previous descriptions, 
you may use the scroll bar by positioning the pointer over 
the scroll arrow and pressing the mouse button. 

Talking To Legacy 
You may control Dagon's actions through the English 

commands that you type into your Macintosh whenever 
there is a prompt (>). These commands usually start with a 
verb and may Include nouns, adjectives, and prepositional 
phrases. After pressing the Return key, Legacy Interprets 
the command and tells you the result of your action. Some 
sample commands are: 

Examine the ancient book on the table. 
Climb down the ladder. 
Move the table. 
Take the box. 
Drop the box. 

You may also use a command that performs two actions. 
For example: 

Drop the rock then go west. 
Take the large rock and the lamp. 

If you enter a command that Legacy doesn't understand, 
try using different words to describe the same action. If 
Legacy still doesn't understand, or replies that the action is 
Impossible, you might conclude that what you were trying to 
do may not be necessary to complete the quest. 
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Movement In Legacy 
There are a number of ways to travel around the forest. 

One way is to type in commands-either full sentences or 
abbreviations: 

Go to the north. 
Go west. 
Walk to the south. 
East 
South. 
N. 
w. 

Other directions may include: 

Go up. 
Go down 
Walk down. 
Up. 
Down 
D. 
A second way to travel in Legacy involves using the Direc­

tion menu. By choosing one of the six items from the Direc­
tion menu, you will travel once in that direction. For exam­
ple, to travel north, choose North from the Direction menu 
by positioning the pointer over Direction. Press the mouse 
button, move the pointer down, and release over North. If the 
item in menu is dimmed, travel in that direction is not possi­
ble. 

The last type of movement in Legacy involves traveling in 
and out of places. When confronted with an opening such as 
a door, an archway, or the mouth of a cave, you must type in 
special commands to pass into the area beyond. Examples 
are: 

Enter the cave. 
Walk in the house. 
Go in the cabin. 

Exit. 
Leave. 
Go out. 

Saving A Game Position 
If you want to stop playing, but would like to continue 

at a later time from the position you are at, you may save 
your position. To do this, choose Save from the File menu 
and click the Save button in the dialog box. Note that each 
time you save a game position, you delete the position that 
is currently saved. In other words, you may have only one 
game position stored. 

Resuming A Game Position 
To return to a saved game position, load Legacy and then 

choose Resume from the File menu. Clicking the Resume 
button in the dialog box will magically transport you through 
time and space to the last position you saved. 

Quitting Legacy 
To stop playing Legacy, choose Quit from the File menu. 

A dialog box will appear asking if you wish to quit Legacy. 
Clicking the Quit button will eject the disk, while clicking 
the Cancel button will return you to the game. One question 
you should always ask yourself before clicking the Quit but­
ton is "Have I saved my game position?" 

Beginning A New Game Quickly 
If you wish to begin your quest again, you may choose 

New from the File menu. You will return to your starting 
position without having to restart the computer. 
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Legacy's Menus 
Legacy has six pull-down menus which perform many 

useful functions. 

The Apple menu . 
Choosing About Legacy ..• will display information about 

Legacy and its creators. . 
Choosing Note Pad will allow you to JOt down notes or 

reminders. 
Choosing Alarm Clock will display the time and allows 

you to set the alarm-an invaluable feature for those play~rs 
who tend to lose track of time while they're exploring 

another world. 
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The Fiie menu 
The File menu contains the New, Save, Resume, and Quit 

commands which are explained on page 9. 

The Inventory menu . 
This menu informs you of what items are currently m your 

possession. Note that choosing an item from this menu has 
no effect. 

The Direction menu 
By choosing one of the directions listed in this menu, you 

will travel once in that direction. This and other methods of 
travel are explained on page 8. 

The Options Menu 

Turn • • More • • Off 
Sometimes the description for a location is too long to be 

contained within the six lines of the text window. When this 
occurs, you will see"* * More • *"appear where the loca­
tion titles are normally."* • More• *"indicates that there is 
more text to be read, and hitting the space bar or the Return 
key will display the remaining text. 

Once you become familiar with the descriptions in 
Legacy, you may find it a nuisance to be confronted with"* 
• More • *" indicators. Choosing the Turn • • More • • Off 
option will allow Legacy to automatically scroll past the"*• 
More **" indicators and bring you to the awaiting prompt(>). 

Hide Picture 
Choosing this item will remove the graphics window and 

extend the text window to cover a larger portion of the 
screen. Removing the graphics window speeds up the flow 
of the game significantly. 

The Score Menu 
This menu informs you of your current score out of a 

possible 200 points. 
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Chapter Two: 
Dagon's Mysterious Quest 

Dagon Bathraal had spent most of the evening under the 
stars on his Meeralath Circle. He had been unsuccessfully 
trying to summon Myrr, a Good Spirit of the Night. The 
mystic white circle, which lay atop a great precipitous crag 
high in the Brandsmoor Mountains, seemed to glow with an 
unnatural light beneath Dagon's feet. Dagon stood at the cir­
cle's center, peering about the moonlit mountainside, 
wondering if he should attempt the complex conjuration 
one last time. With eyes lifted towards the heavens, he sud­
denly had the terrible feeling that his powers were tiny and 
unseen in the vast ocean of the universe. 

But Dagon put this troubling thought aside with an im-
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pulsive conviction that seemed to come more from 
somewhere in the night than from within his heart. Taking a 
quick, deep breath of the cool and misty night air, Dagon 
once again concentrated on his great spell of summoning. 

He peered at the white circle on the rocky ground beneath 
him, making sure his footing thereon was correct and didn't 
obstruct any of the lines that controlled the intensely power­
ful flow of preternatural forces neccessary to conjure one of 
the ethereal entities of the night. He then raised his arms 
and head towards the moon and the stars in the beginning 
gesture. 

If everything went correctly, he would direct an intense 
beacon of mystic energy out into the night that would sum­
mon Myrr. With that energy, Myrr would be able to transcend 
his ethereal barriers and slide down to the Meeralath Circle 
upon a silky moonbeam. This moonbeam, being quite invisi­
ble to the naked eye, would then be filtered through a 
pointed, upjutting rock next to the circle that is pierced with 
a small oval eyelet. The moonbeam, passing through this 
eyelet, would be magically enhanced so as to make it a visi-

ble be~m of light. This blue beam would then land upon a 
r~cept1ve circle where a small image of Myrr would dance to 
life and speak with Dagon. 

Dagon b.egan chanting in a low and even tone that seemed 
to blend in perfectly with his surroundings. His words 
became one with the night, intermingling with its mists and 
vapors and .harmonizing sympathetically with its serene 
c~lmness. His. arms then began tracing odd patterns in the 
air as the magical web w~s spun and the spell started gain­
ing momentum. A great wind arose behind Dagon and it rak­
ed through the leaves of the low shrubbery that clung to the 
rock of the mountainside and howled off the stony crag 
~here Dagon Stood. The pitch of Dagon's chant began to 
nse and fall and the wind gusted violently in accord with 
these. fluctuatio~s. Rapidly, the spell became more and 
~ore intense as 1t drew in the great amount of mystic energy 
1t needed to be successful. 

And then, with the f!nal word,"Myrr,"and a great sweeping 
gestu~e, the arcane signal was cast out into the vast night 
sky with hopes of contacting a single entity in an obscure 
realm. 

Dag?n stoo~ expectantly for several moments, his 
breathing loud in the uneasy silence that lay in the after­
m.ath of the conjuration. The air stood motionless, charged 
with a tense hopefulness that was rooted around Dagon's 
~oul. It seemed as if the whole world was holding its breath 
in great anticipation, awaiting the moment that the rock's 
eyel.et would emit its blue beam: the harbinger of success. 

Silence. 
He knew it had already been too long, but Dagon could 

not remove his transfixed gaze from the oval eyelet. To do 
that would have been abandoning all hope of success 

More Silence. ··· 
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Then once again an impulsive conviction took Dagon 
over an

1

d he looked away, dejectedly shaking his head. He 
turned slowly and began climbing the great flight of stairs to 
his lofty dwelling above with excessive disappointment. 

"A dramatic release of positive energy," Dagon began 
muttering, "but apparently not enough to reach Myrr ... 
unless, perhaps, the problem lies not within the amount of 
magic energy but within ... " 

Dagon could not utter one more word for what he saw 
made his heart soar: a blue light illuminated the area around 
him. He whirled around to see a beam of light flicker­
ing between the oval eyelet and the receptive circle. It flash­
ed with a bright radiance that sent light dancing about the 
entire mountainside. 

Finally, the glowing beam reached constancy, and Dag~n 
saw a strange figure take form: a wisened old man, clad in 

the robes of a wizard. This certainly was not Myrr, one of the 
countless Spirits of the Night-no, this being had an air of 
immeasurable power; power far beyond the likes of Myrr and 
his ethereal kin. 

The image then spoke with a voice much deeper and 
louder than would have been expected from a figure no more 
than three spans In height: "Ah my dear Dagon, step down 
here where we can discuss some very pressing matters of 
great importance." 

Dagon who had been frozen with excitement, stumbled 
awkwardly down the stairs to his Meeralath Circle and knelt 
before the aged wizard whose flowing garb was completely 

gray. . 
The wizard then continued in his immense voice that was 

quite unearthly: "I am Arkimar, the eldest of the Wizards of 
the Universe, and you have been a subject of great interest 
to me for quite some time now. 
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"I have finally decided that you are the One; yes, the 
Chosen One who will embark upon my mysterious quest. 
Listen closely so that you do not forget my words. 

"You, Dagon Bathraal, must journey far into the northern 
lands, west of the Brandsmoor Mountains. There lies the 
grand Frimlock Forest with its wise old oaks, many of which 
are thirty generations old. From there you must continue 
northward into the dark and evil Secryll Forest until you 
come upon the northern sea and the fabled Drab Castle-a 
castle so twisted and malign its evil stills the air. You must 
enter this castle and procure a mystic orb which you must 
then place in my hand. To complete this quest it will only be 
necessary for you to bring the most prized of your many 
spellbooks, Lahmed Nimphinatu. 

"And one thing I never want you to forget, Dagon, is the 
power of the Good that flows so easily through your body. 
Never underestimate its potency and never, for even one 
moment, believe it has a limit, for that will be the day that it 
ceases to work for you. " And with those words and a wave 
of his hands, Arkimar vanished as quickly and as unex­
pectedly as he had arrived. 

Dagon stood for many minutes staring at the now empty 
receptive circle in a stupor. His mind was racing. He 
thought, "What if I refuse this quest?" But he wouldn't do 
that - he couldn't.. Somehow he knew he had no choice ... 

How he had climbed the stairs and entered the door of his 
house was a mystery to Dagon, but now he sat at his 
candlelit reading table excitedly absorbing information 
about the Wizards of the Universe: 
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... The Wizards of the Universe Is a unique sect 
in that Its members hold totally neutral views and 
believe that the universe can survive only through 
a balance of good and evil. Being the most power­
ful organization of mystics ever to exist In the 
history of the cosmos, the Wizards of the Universe 
seem to have locked upon the true nature of ex­
istence. Through their procrustean missions, they 
have obtained an unusual sense of balance and 
well-being through out every corner of the 
universe. On most worlds, however, the Great 
Sect is only material for fables and myths, for it 
has been thousands of years since the Wizards 
have had any need to campaign upon these 
worlds ... 

Such was the case with Dagon's world. Dagon could vivid­
ly remember, as a very young child, hearing the only tale he 
had ever heard of the Wizards of the Universe told by a wise 
old seer who had traveled from a distant corner of the earth 
to visit his village. He could remember how he had listened 
with wide-eyed wonder at the story of the great deeds and 
magic of the Wizards. For some reason he could never 
forget that story ... 

Dagon fell into bed, exhausted, and lost himself to sleep 
while reliving his moonlit encounter with the gray-robed 
Arkimar for the thirteenth time. 

The next day broke bright and clear and Dagon packed 
whatever magical trinkets he had, plus his beloved 
spellbook Lahmed Nimphinatu and then promptly departed 
on his long journey. 

It was on the thirteenth night of travel that Dagon found 
the edge of the Frimlock Forest. Lying by a warm, comfor­
ting fire and staring up at the bejeweled night sky, Dagon 
wondered what mysteries would be unveiled on the follow­
ing day ... 

Glossary 

Arkimar - .one of the thirteen " Wizards of the Universe." 
He has assigned you the task of recovering a mystic orb 
from the Drab Castle. 

Dagon B~thraal - You. You assume the role of Dagon and 
complete his quest. 

Drab Castle - An evil castle located deep within the 
Sechryll Forest. It contains the mystic orb. 

Great Sect - Another name for the Wizards of the Universe. 

Frimlock Forest - The forest of great oaks that borders the 
edge of the Sechryll Forest. 

Lahmed Nimphinatu - Your beloved spellbook. 

Misty River - The magical river that flows northward 
through the Frimlock Forest and into the Sechryll Forest. 

Sechryll Forest - The evil forest of tangled trees in which 
the Drab Castle is located. 

. The Wizar?s of the Universe - The most powerful organiza­
tion of mystics to ever exist in the history of the cosmos. 
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